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WDO.1

Overview of Microsoft Office Word 2007

• What Is Word Processing?
Office Word 2007 is a word processing software application whose purpose
is to help you create any type of written communication. A word processor
can be used to manipulate text data to produce a letter, a report, a memo,
an e-mail message, or any other type of correspondence. Text data is any
letter, number, or symbol that you can type on a keyboard. The grouping of
the text data to form words, sentences, paragraphs, and pages of text
results in the creation of a document. Through a word processor, you can
create, modify, store, retrieve, and print part or all of a document.

Word processors are one of the most widely used application software
programs. Putting your thoughts in writing, from the simplest note to the
most complex book, is a time-consuming process. Even more time-consuming
is the task of editing and retyping the document to make it better. Word
processors make errors nearly nonexistent—not because they are not made,
but because they are easy to correct. Word processors let you throw away the
correction fluid, scissors, paste, and erasers. Now, with a few keystrokes, you
can easily correct errors, move paragraphs, and reprint your document.

• Word 2007 Features
Word 2007 excels in its ability to change or edit a document. Editing involves
correcting spelling, grammar, and sentence-structure errors. In addition, you
can easily revise or update existing text by inserting or deleting text. For
example, a document that lists prices can easily be updated to reflect new
prices. A document that details procedures can be revised by deleting old
procedures and inserting new ones. This is especially helpful when a
document is used repeatedly. Rather than recreating the whole document,
you change only the parts that need to be revised.

Revision also includes the rearrangement of selected areas of text. For
example, while writing a report, you may decide to change the location of
a single word or several paragraphs or pages of text. You can do it easily
by cutting or removing selected text from one location, then pasting or
placing the selected text in another location. The selection also can be
copied from one document to another.

To help you produce a perfect document, Word 2007 includes many
additional support features. The AutoCorrect feature checks the spelling
and grammar in a document as text is entered. Many common errors are
corrected automatically for you. Others are identified and a correction
suggested. A thesaurus can be used to display alternative words that have
a meaning similar or opposite to a word you entered. A Find and Replace
feature can be used to quickly locate specified text and replace it with
other text throughout a document. In addition, Word 2007 includes a
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variety of tools that automate the process of many common tasks, such as
creating tables, form letters, and columns.

You also can easily control the appearance or format of the document.
Formatting includes such operations as changing the line spacing and margin
widths, adding page numbers, and displaying page headers and footers. You
also can quickly change how your text is aligned with the left or right margin.
For example, text can be centered between the margins, or justified—evenly
aligned on both the left and right margins. Perhaps the most noticeable
formatting feature is the ability to apply different fonts (type styles and sizes)
and text appearance changes such as bold, italics, and color to all or selected
portions of the document. Additionally, you can add color shading behind
individual pieces of text or entire paragraphs and pages to add emphasis.

To make formatting even easier, Word 2007 includes Document Themes
and Quick Styles. Document Themes apply a consistent font, color, and line
effect to an entire document. Quick Styles apply the selected style design to a
selection of text. Further, Word 2007 includes a variety of built-in prefor-
matted content that help you quickly produce modern-looking, professional
documents. Among these are galleries of cover page designs, pull quotes, and
header and footer designs. While selecting many of these design choices, a
visual live preview is displayed, making it easy to see how the design would
look in your document. In addition, you can select from a wide variety of
templates to help you get started on creating many common types of
documents such as flyers, calendars, faxes, newsletters, and memos.

To further enhance your documents, you can insert many different types of
graphic elements. These include drawing objects, SmartArt, charts, pictures,
and clip art. The drawing tools supplied with Word 2007 can be used to create
your own drawings, or you can select from over 100 adjustable shapes and
modify them to your needs. All drawings can be further enhanced with 3-D
effects, shadows, colors, and textures. SmartArt graphics allow you to create
a visual representation of your information. They include many different
layouts such as a process or cycle that are designed to help you communicate
an idea. Once created, you can quickly enhance them using a Quick Style.
Charts can be inserted to illustrate and compare data. Complex pictures can
be inserted in documents by scanning your own, using supplied or purchased
clip art, or downloading images from the World Wide Web. Additionally, you
can produce fancy text effects using the WordArt tool.

Word 2007 is closely integrated with the World Wide Web. It detects when
you are typing a Web address and converts it to a hyperlink automatically for
you. You also can create your own hyperlinks to locations within documents,
or to other documents, including those at external locations such as a Web
site or file server. Word’s many Web-editing features help you quickly create
a Web page. Frames can be created to make your Web site easier for users to
navigate. Pictures, graphic elements, animated graphics, sound, and movies
can all be used to increase the impact of your Web pages.

Group collaboration on projects is common in industry today. Word 2007
includes many features to help streamline how documents are developed and
changed by group members. A discussion feature allows multiple people to
insert remarks in the same document without having to route the document
to each person or reconcile multiple reviewers’ comments. You can easily
consolidate all changes and comments from different reviewers in one simple
step and accept or reject changes as needed.

You also can create and send an entire document by e-mail or Internet
Fax service directly from within Word 2007, using all its features to create
and edit the message.
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• Case Study for Office Word 2007 Labs
As a recent college graduate, you have accepted a job as advertising
coordinator for Adventure Travel Tours, a specialty travel company that
organizes active adventure vacations. The company is headquartered in
Los Angeles and has locations in other major cities throughout the
country. Your duties include the creation of brochures, flyers, form letters,
news releases, advertisements, and a monthly newsletter, all of which
promote Adventure Travel’s programs. You are also responsible for
working on the company Web site.

Brief Version
Lab 1: Adventure Travel Tours has developed four new tours for the
upcoming year and needs to promote them, partly through informative
presentations held throughout the country. Your first job as advertising
coordinator is to create a flyer advertising the four new tours and the
presentations about them.

Lab 2: Your next project is to create a letter to be sent to past clients. The
letter briefly describes Adventure Travel’s four new tours and invites
clients to attend an informational presentation.

Lab 3: Part of your responsibility as advertising coordinator is to gather
background information about the various tour locations. You will write a
report that includes a cover page, table of contents list, and footnotes,
providing information about Tanzania and Peru for two of the new tours.

Working Together: Adventure Travel Tours has a company Web site. You
will convert the flyer you developed to promote the new tours and
presentations to be used on the Web site.

• Before You Begin
To the Student

The following assumptions have been made:

• Microsoft Office Word 2007 has been properly installed on your
computer system.

• You have the data files needed to complete the series of Word 2007
labs and practice exercises. These may be supplied by your instructor
and are also available at the online learning center Web site found at
www.mhhe.com/oleary.

• You are already familiar with how to use Microsoft Windows XP or
Vista  and a mouse.

To the Instructor

A complete installation of Microsoft Office 2007 is required in which all
components are available to students while completing the labs. In several
labs, an online connection to the Web is needed to fully access a feature.

Please be aware that the following settings are assumed to be in effect
for the Office Word 2007 program. These assumptions are necessary so
that the screens and directions in the labs are accurate. These settings are
made using Office Button/ in the categories shown below.
Features are on when there is a check mark in the check box.
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Popular

• The Mini Toolbar feature is selected.

• Always use ClearType is on.

• The Live Preview feature is enabled.

• The color scheme is set to blue.

• Show feature descriptions in ScreenTips is selected.

• Language is set to English (US).

Display

• Show white space between pages in Print Layout view is on.

• Show highlighter marks is on.

• Show document tooltips on hover is on.

• Print drawings created in word is on.

Proofing

• In the AutoCorrect Options dialog box, all options are on in both the
AutoCorrect and AutoFormat tabs. In the AutoFormat as you type tab,
all options are on except: Bold and italic with real formatting, Built-in
Heading styles, and, Define styles based on your formatting.

• Ignore words in Uppercase is on.

• Ignore words that contain numbers is on.

• Ignore Internet and file addresses is on.

• Flag repeated words is on.

• Check spelling as you type is on.

• Check grammar as you type is on.

• Check grammar with spelling is on.

Advanced/Editing options

• Typing replaces selected text is on.

• When selecting, automatically select entire word is on.

• Allow text to be dragged and dropped is on.

• Use Ctrl�Click to follow hyperlink is on.

• Use smart paragraph selection is on.

• Use smart cursoring is on.

• Keep track of formatting is on.

• Mark Formatting Inconsistencies is off.

• Enable Click and type is on.

Advanced/Cut, Copy, and Paste

• The four Pasting options are set to their default settings.

• The Insert/paste pictures as option is set to In line with text.

• Keep bullets and numbers when pasting text with Keep Text Only option.

• Show Paste Options button is on.

• Use smart cut and paste is on.
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Advanced/Show document content

• Show drawings and text boxes on screen is on.

• Show text animation is on.

• Show Smart Tags is on.

Advanced/Display

• Show 17 Recent Documents.

• Show all windows in the Taskbar is on.

• Show shortcut keys in ScreenTips is on.

• Show horizontal and vertical scroll bars is on.

• Show vertical ruler in Print Layout view is on.

Additionally, the following assumptions are made:

• The feature to access Online Help is on. (From the Help window, open the
Connection Status menu and choose Show Content from Office Online.)

• All default settings for the Normal document template are in effect.

• All figures in the text reflect the use of a display monitor set at 1024 by
768 and the windows XP opearting system. If other monitor setting
are used, there may be more or fewer lines of information displayed in
the windows than in the figures. If the windows vista operating system
is used, some features may look slightly different.

• Instructional Conventions
Hands-on instructions you are to perform appear as a sequence of numbered
steps. Within each step, a series of bullets identifies the specific actions that
must be performed. Step numbering begins over within each topic heading
throughout the lab. Four types of marginal notes appear throughout the
labs. Another Method notes provide alternate ways of performing the same
command. Having Trouble? notes provide advice or cautions for steps that
may cause problems. Additional Information notes provide more infor-
mation about a topic. More About notes refer you to the more about word
2007 appendix for additional information about related features.

Commands
Commands that are initiated using a command button and the mouse
appear following the word “Click.” The icon (and the icon name if the icon
does not include text) is displayed following “Click.” If there is another
way to perform the same action, it appears in an Another Method margin
note when the action is first introduced as shown in Example A.

When a feature has already been covered and you are more familiar with
using the application, commands will appear as shown in Example B.

Example A

1 • Select the list of four tours.

• Open the Home tab.

• Click Bold in the Font group.

Another Method
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Example B

1 • Select the list of four tours.

• Click Bold in the Font group of the Home tab.

OR

1 • Bold the list of four tours.

File Names and Information to Type
Plain blue text identifies file names you need to select or enter. Information
you are asked to type appears in blue and bold. (See Example C.)

Example C

1 • Open the document wd01_Flyer.

• Type Adventure Travel presents four new trips.

Office Button
Clicking Office Button opens the File menu of commands. File menu
commands that you are to use by clicking on the menu option appear
following the word “Choose.” Items that are to be selected (highlighted) will
follow the word “Select” and will appear in black text. You can select items
with the mouse or directional keys. Initially these commands will appear as
in Example A. As you become more familiar with the application, commands
will appear as shown in Example B.

Example A

1 • Click Office Button.

• Choose Open.

• Select My Documents from the Look In drop-down menu.

• Select Flyer1.docx.

• Click .

Example B

1 • Choose Open from the File menu.

• Choose Flyer1.docx.

The keyboard shortcut is
c�B.

Another Method
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